


CD Browser Help Contents
To learn how to use Help, press F1.

Using CD Browser
A complete guide to CD Browser with step-by-step instructions

Reference Information
Thorough explanations of CD Browser components

 Programming with ImagePals
Information about the Ulead ADK and how to order it

Technical Support
How to contact Ulead Systems if you have questions

Other ImagePals Program Helps
Quick access to on-line help for all other ImagePals programs



Reference Information
How to Use This Help

Menu Commands
The CD Browser Ribbon
Shortcuts
Glossary



Using CD Browser
Viewing a photo
Saving a photo as an image



Menu Commands
File Menu
View Menu
Help Menu
Switch Menu

Related topic
Window Control Menu



    File Menu
Load PhotoCD disc
Run Image Editor

Insert Thumbnails into Album

Save As
Select All
Select None
Select Invert

Preferences
Exit



    View Menu
Run Viewer

Disc Information

Photo Information



    Help Menu
Contents
Search for Help
How to use Help
About Ulead Products
About CD Browser



    Switch Menu

This menu contains the names of the other ImagePals programs. Click on a name and the 
corresponding program is invoked. You can also access the Windows Program Manager, File Manager 
and Clipboard Viewer (if available).



    Window Control Menu

Every window has its own control menu in the top left corner to manage the window itself. Some control
menus also contain an additional command such as Next or Run. These commands allow you to swap 
between windows.

Restore restores a window to its normal size (i.e. the size it was before being maximized or 
minimized)

Move allows you to move the window
Size allows you to change the size of the window
Minimize reduces the window to an icon
Maximize enlarges the window to fill all available space (either on screen or within a parent 

window)
Close closes the window
Switch To brings up the Windows Task List dialog box



Shortcuts

CD Browser has a few shortcuts that allow you to access commands and open dialog boxes without 
going through the menus.

Click here to print this topic
Click here to close this window

File Menu
Ctrl + P Accesses a PhotoCD disc
Ctrl + G Launches the Image Editor program
Ctrl + I Displays the Insert Thumbnails into Album dialog box
Ctrl + A Displays the Save As dialog box
Ctrl + L Selects all the photos
Ctrl + N Deselects selected photos
Ctrl + Q Exits CD Browser

View Menu
Enter Accesses the Viewer application

Help Menu
F1 Displays the CD Browser Help window
Shift + F10 Displays the Microsoft Windows Help window

Miscellaneous
Double-click status bar Displays the Preferences dialog box.
Click right mouse button Displays information about a photo
Esc Closes dialog boxes without making changes



Load PhotoCD disc
This command allows you to access a new PhotoCD disc in the CD-ROM drive.



Run Image Editor
Starts the Image Editor program.
The selected photos appear in the Image Editor workspace.



Insert Thumbnails into Album
Inserts thumbnails into an existing album, or a newly created one.

Related topic
Insert Thumbnails into Album dialog box



Select All
Selects all the photos on the disc.



Select None
Deselects all selected photos.



Select Invert
Deselects the currently selected photos, and selects the photos that were not selected.



Preferences
Allows you to customize some of the features of CD Browser.

Related topic
Preferences dialog box



Exit
Closes the CD Browser application.



Disc Information
Displays a dialog box containing information about the PhotoCD disc.

Related topic
Disc Information dialog box



Photo Information
Displays a dialog box containing information about a selected photo.
Note: Click the right mouse button on a photo to display the same information.

Related topic
Photo Information dialog box



Contents
Starts Help and displays the topics in the CD Browser Help



Search for Help on
Opens the Search dialog box containing keywords from the Help topics



Glossary
Definitions of terms used by ImagePals programs and documentation.



Technical Support
How to contact Ulead Systems when you have questions.



How to Use Help
Accesses the Windows guide to using Microsoft Help



About CD Browser
Displays the CD Browser product information box



About Ulead Products
About Ulead Products displays information about other products from Ulead System



Viewing a photo

Use the Run Viewer command from the View menu, or click on the Viewer button in the ribbon, to open 
a selected photo in a Viewer window. You can also double-click on a thumbnail.

If you want to open multiple photos simultaneously, select them with the Ctrl or Shift keys, 
or choose the Select All command from the File menu to open all the photos in one 
operation (depending on your system resources, you may not be able to open all the 
photos in a disc at the same time).
Each photo opens in its own Viewer window, at the resolution and data type you choose in 
the Preferences dialog box, or in the ribbon.
Please consult Viewer on-line help for more information.

Related topic
Preferences dialog box



Saving a photo as an image

Use the Save As command from the File menu to save a photo as an image file. The PCD format is not 
recognized as an image file, so you need to specify an image file format to save your photo in and, if a 
compression option is available, whether or not to compress it.

1. Choose "Save As" to display the Save As dialog box.
2. From the Directories list box, choose the drive and directory to which you want to save the photo.
3. Select a format from the List Files of Type drop-down list box.
4. In the File Name text box type the name of your new image (up to eight characters). You do not need to

enter the file extension.
5. Click OK to save the photo as an image.

Related topics
Save As dialog box
Supported File Formats



Save As
File Name allows you to enter a filename or, if you wish to overwrite an existing file, select its 

filename from the files list box
List Files of Type lists the available file formats and their extensions
Directories shows the current path and any subdirectories under that path
Drives lists all the available drives
Options opens the save options dialog boxes for file formats that provide options
Browse opens the Browse dialog box, use this dialog box to search for files
Network allows you to connect to a network (only available if you are running Windows for 

Workgroups)
Save to Album allows you to choose whether or not to save a thumbnail of the image to Album
Album opens the Insert Thumbnails to Album dialog box. Use this to place the photo into albums 

in Album's workspace or into a newly created album

Related topic
Saving a photo as an image



Preferences
CD-ROM Drive lists the available CD-ROM drives on your system
Resolution lists the different resolutions you can choose to view a photo, from thumbnail to full 

size
Data Type lists the data type you can choose to view the photos, grayscale, Indexed 256-Color, 

or RGB True Color
Background Color determines the color of the background behind the photos. You can choose 

from four preset options or define your own with the Pick Color button



Disc Information
Serial Number indicates the serial number of your PhotoCD
Creation Time indicates the creation date and time of your CD
Modification Time indicates the date and time when photos were last encoded in your CD
Sessions indicates the number of times you encoded photos in your CD



Photo Information
Creation Time indicates the creation date and time of the photo
Modification Time indicates the latest modification date and time of the photo (same as creation 

time if the photo has never been modified)
Has Copyright ? indicates if the image possesses a copyright
Photo Finisher shows information which you request your bureau to encode
Copyrights opens an existing copyright information



The CD Browser Ribbon

The ribbon at the top of the CD Browser window allows you to select which drive to use, as well as the 
resolution and the image data type for the photos opened in Viewer.

The changes you made here affects the settings in the Preferences dialog box.
Click on each option below for more information:



This list box lists the available CD-ROM drives on your system.



This list box lists the different resolutions you can choose to view a photo, from thumbnail to full size.
Every photo in your photo CD contains five different image resolution. You can select a resolution to 
open and view the image in the Viewer or the Image Editor application.



This list box lists the data type you can choose to view the photos: Grayscale, Indexed 256-Color, or 
RGB True Color.



Run Viewer
Opens the Viewer program, where you can view and edit the selected photo.

If you want to open multiple photos simultaneously, select them with the Ctrl or Shift keys, 
or choose the Select All command from the File menu to open all the photos in one 
operation (depending on your system resources, you may not be able to open all the 
photos in a disc at the same time).
Each photo opens in its own Viewer window, at the resolution and data type you choose in 
the Preferences dialog box, or in the ribbon.
Please consult Viewer on-line help for more information.



Filenames can be entered with or without a file extension. If no extension is entered, the extension 
selected in the List of Files Type drop-down list box is automatically added.



This line informs you if the photo has a specific copyright. Most photos on a CD have copyright 
protection belonging to the photographer and/or the manufacturer.
If the copyright line is empty, you cannot assume that a photo is without copyright.



The information displayed here can include the name of the photographer, the name of the developing 
company, and the name of the bureau.



When you click on this button, Windows Notepad opens a file containing relevant Copyright information 
for the photos in your CD.
Pay particular attention to this information to determine the extent to which you can use the photos.



Every photo in your photo CD contains five different image resolution. You can select a resolution to 
open and view the image in the Viewer or the Image Editor application.



Browse



bmp



eps



iff



jpeg



psd



ras



tga



tif



Other ImagePals Program Helps

Album

Image Editor

Screen Capture

Viewer



Ulead ADK
 What is the ADK? 
 What can you do with the ADK? 
 What does the ADK contain  ?   
 Ordering Informatio  n   

Technical Support



What is the ADK?

The Ulead ADK is a set of sample programs with accompanying documentation. The 
documentation shows the application programming interface (API) calls supplied by Album 
and other Ulead programs. Other applications can call these APIs for access to Ulead 
program features such as reading and writing image data file. 

The ADK also shows sample programs for writing File Input/Output (FIO) and Media 
Input/Output (MIO) filters so Ulead products can access or catalog foreign file formats.

Related topics
What can you do with the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What can you do with the ADK?

With ADK you can do the following:
Find existing IAC (Inter Application Compatible protocol) compatible programs to take 

advantage of existing MIO or FIO filters
Allow users to drag and drop files from your application into Album as thumbnails, 

and vice versa
Register your application as an IAC compatible program: you can insert thumbnails 

into albums when saving files and your application will be shown along with other Ulead 
products in the Switch menu. 

Create albums or insert thumbnails to albums for cataloging and browsing purposes.
Access a file format using existing FIO filters
Do file conversion using existing FIO filters.
Create new FIO filters for reading and writing specific multimedia file formats
Create new MIO filters for generating thumbnails and for cataloging specific 

multimedia file formats

Related topics
What is the ADK?
What does the ADK contain?
Ordering Information
Technical Support



What does the ADK contain?

The ADK consists of the following items:
Ulead ADK introduction
Ulead ADK document
Sample program diskette
License Notice and Distribution Agreement
Development Support Option
Suggestion Form
Order Form

Related topics
What is the ADK?
What can you do with the ADK?
Ordering Information
Technical Support



Ordering Information

This list shows the ADK packages and their per unit prices. All prices are in US dollars and 
subject to change without notice.

Base Produc  t:      $ 600
Base Product with Development suppor  t:      $ 2,100
Development Suppor  t:      $ 1,500
Shipping and Handling (Asia):    $ 35
Shipping and Handling (Worldwide):    $ 50
North and South American orders
International orders

Related topics
What is the ADK?
What can you do with the ADK?
What does the ADK contain?
Technical Support



Technical Support

If you have any questions or comments about this or any other Ulead products, we want to 
hear from you. Ulead has three offices to help you:
Before you call, please prepare the following information so we can offer you the best 
possible support:

The program name and serial number
Nature of the problem
Any error messages or dialog boxes that appear when the problem occurs
System information including the type CPU, your operating system, and any other 

programs running at the time the problem occurs.
If you decide to write or fax us, add printouts of the following:

AUTOEXEC.BAT
CONFIG.SYS
WIN.INI
ULEAD.INI

Note: You can obtain copies of these files quickly by running SYSEDIT.EXE in your Windows 
program directory.

In North and South America
Europe
International 



In North and South America

Our California offices are open Monday through Friday from 9:00 AM to 5:00 PM Pacific 
Standard Time.

Phone us at 
(310)-523-9393

Fax us at 
(310)-523-9399

Write to us at
Ulead Systems, Inc.
970 West 190th Street, Suite 520
Torrance, CA 90502

Call the Ulead BBS at
(310)-523-9389 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



International

Our international headquarters in Taiwan, R.O.C. has personnel fluent in English, French, 
German, and Chinese available to help. Office hours are Monday through Friday from 9:00 
AM to 6:30 PM Taiwan time.

Phone us at 
+886 (2) 764-8599

Fax us at 
+886 (2) 764-9599

Write to us at
Ulead Systems, Inc.
12F-A, 563 Chung Hsiao E. Rd.,
Sec 4,
Taipei, Taiwan, R.O.C.

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



Europe

Our Customer SupportCenter in Germany is open Monday through Friday from 8:00 AM to 
5:00 PM GMT.

Phone us at 
+49 6042-68472

Fax us at 
+49 6042-68575

Write to us at
Ulead Customer Support.
An der Saline 31
D-63654 Büdingen, BRD

Call the Ulead BBS at
+886-2-764-7585 19200 bps (N,8,1)

Or send EMail to
(MCI Link gateway on Internet)

ULead@mcimail.com 
(MCI Mail)

EMS: ULead / MCI ID: 522-0621
MBX: Support @ ultc 

(Compuserve)
101400,221 

(Internet)
ulead@c2.hinet.net 

-or-
idpt871@tpts1.seed.net.tw



The base product contains the ADK and access to public bulletins and messages on the 
Ulead BBS.



The base product with development support contains the ADK an complete technical support
via fax, EMail, or BBS for sixty (60) days or twenty (20) hours, whichever comes first.



Development support offers extended technical support to those who already own the ADK 
via fax, E-Mail, or BBS. Each contract covers sixty (60) days or twenty (20) hours, whichever 
comes first.




